The purpose of this exercise is to re-enforce what you have learned about kinematics in class and to familiarize you with computer resources available to you for analyzing kinematic systems. There is no pre-laboratory exercise for this week, but please be sure that you have read through these pages carefully **BEFORE** coming to lab so that you are prepared to work once you get into the lab. There will be an exercise following the lab, which will invite you to demonstrate your understanding of kinematics and your mastery of this analytical procedure; in other words, pay careful attention in the lab because you will be expected to repeat parts of this process on your own. Feel free to bring your text book, your class notes, or any other materials that might help you with the lab.

**Overall GOAL:** To determine the equation, *in differential form*, that describes the motion of a freely-falling object.

* That means an equation with a derivative in it.

**PART 1: DATA**

**GOAL of This Part:** To gather usable data (time and position) of a freely-falling object.

To record the time and position of a falling object you will use a **SPARK TIMER**. This apparatus can be set to a certain discharge frequency (on this machine, 10 Hz or 60 Hz) so that at every $\frac{1}{10}$ or $\frac{1}{60}$ of a second it will discharge a spark and leave a mark on a strip of recording paper. This will allow us to record at regular time intervals the position of an object which is attached to the end of the strip of paper. (The friction between the paper and the machine can be considered negligible.)

**A. OBTAINING DATA:** First use a level to be sure that the spark timer is not tilted in any way. Next, rip off a two-to-three foot long strip of recording paper from the roll. Make sure that the spark timer is off, and then feed the strip through the top of the spark timer as indicated by the arrow on the machine, leaving about a centimeter of paper exposed at the bottom. Attach a string of four alligator clips to this end of the paper and turn the machine on. Set the discharge frequency to 60 Hz. Finally, check that the paper is not tangled and that nothing
(the table, the wire, etc.) is in the path of the falling paper and alligator clips. Then release the paper. Turn the machine off when you are finished.

B. **ORGANIZING DATA:** You will now need to measure the positions of the marks on the paper in meters using a meter stick. You can avoid the problem of **parallax** by reading all your measurements "head on," as the observer does with the middle point below:

![The Problem of Parallax](image)

Also remember that the time interval between each spark is $1/60$ of a second. Make a table of your data in your lab notebook, expressing position $x(t)$ in meters and time $t$ in seconds. Making this conversion now will make subsequent steps much easier.

*Where to start:* Find the first mark that you can see clearly on the recording paper and position it at the zero mark on the meter stick. This is your arbitrary starting point against which position will be measured. You should call it your first data point, located at position $x = 0$ meters and measured at time $t = 1/60 = .016667$ seconds. It is important that you don't assume this to be the initial position marked at time $t = 0$ because you don't know the exact position of the recording paper when the descent began. You will determine the initial position at time $t = 0$ in the next part of the lab.

**PART 2: EQUATIONS OF MOTION**

**GOAL of This Section:** To find an appropriate polynomial equation and an appropriate differential equation to describe the motion of the falling object.
Once you have your data, you need to narrow down your choices for an equation to describe the object’s motion. The program **Curve Fit 0.7d** (located in a folder called **Curve Fit** in the **Physics 13** class folder you obtained from **PUBLIC**) will help you to do that graphically by fitting mathematical functions to sets of data. **Curve Fit** allows you to test polynomial equations of different orders against the data points and to gauge their appropriateness or "fit." You could draw the position vs. time graph in your lab notebook and try to fit the points to different-ordered equations, but for the sake of accuracy and speed the computer is very helpful. It will also calculate for you the numerical coefficients of the best-fitting polynomial for whatever polynomial order you choose.

Instructions for the **Curve Fit 0.7d** program are included in the folder. It is a good idea to **PRINT THESE OUT** so that you can refer back to them as you use the program and so you do not have to flip back and forth between computer windows. Also, you will need to use the program again in a follow-up exercise to this lab, and later work in the course, so hold onto the directions. (Students in past years have told us that they continue to use this program in other courses at Dartmouth so you may want to keep a copy after the end of the term).

A. **DATA INPUT:** Now you need to enter the data from your notebook into the **Curve Fit** data table. You should keep in mind that the **X-Coord** column in the table, represented on the horizontal axis, is used for the independent variable, and you should decide which of the two variables proceeds independently of the other in this case - time t or position x? The other measurement, represented in the **Y-Coord** column and on the vertical axis, is the dependent variable. (**You should note that the "X" in the Curve Fit program and the values of "x" in our experiment are not the same**) After you fill in the data (the first 18 points should be sufficient), the program will plot the data points for you.

**Dependent and Independent Variables:** The horizontal axis displays the independent variable, which proceeds unaffected by other factors in the experiment. The dependent
variable proceeds as a consequence of the independent one. In other words, the dependent variable is a function of the independent one, a mathematician expresses this functional dependence by writing something like:

\[ \text{dependent} \ (\text{independent}) \]

or in this case:

\[ x \ (t) \]

Be sure to label the independent and dependent variables in your notebook.

B. FITTING EQUATIONS: Now, at the top of the Macintosh screen in the menu bar you will see an item at the right called Curve Fit. Pull the menu down and you will see your choices for the type of equations to which you may try to fit your data.

1. Start with a Linear equation. Click the OK button and the program will fit the best straight line to the data. You need to record this best-fitting linear equation in your notebook using the coefficients provided by the program; they correspond to the general formula for a linear equation, which appears in a separate window. Or you can print the equation and coefficients along with a copy of the graph if you prefer. To do that, pull down the File menu and select Print. Be sure to fasten a hard copy entitled "linear" (with data columns and axes clearly labeled) securely into your lab notebook.

2. Now go back to the Curve Fit menu at the top of the screen and this time select Polynomial. A box opens up asking for the order of the fit. Type in 2. Then click OK and the program will fit the best second-order polynomial to your data. Again you need to either record this best-fitting second-order equation in your lab notebook or print out the results by choosing Print from the File menu and fasten a labeled hard copy into your notebook. Call this one "second order."

3. Lastly, you should try to fit a third-order polynomial to your data. Select Polynomial once again from the Curve Fit menu and type in 3 for the order. Remember to record either this best-fitting third-order equation in your lab notebook or print out and label a hard copy and fasten it into your notebook. This should be called "third-order."

C. ANALYSIS: Which type of equation fits your data best? In order to answer this question you need to decide which is the simplest (lowest-ordered) equation that fits the data points. Higher ordered equations may seem to fit just as well, but here we are looking for the simplest representation that does the job.
D. **MATHEMATICAL DEVELOPMENT:** You probably know that for a linear plot, slope can be accurately expressed as \( \frac{Dx}{Dt} \):

\[
x(t)\quad t
\]

However, for a non-linear plot, this description is not sufficient because the slope can vary over an interval \( Dt \). Notice that the slope is different at the three points on the curve below:

\[
x(t)\quad t
\]

1. Make a better approximation for the **slope** of a non-linear plot using an expression with a limit in it. (Remember the way you did it when you first started calculus?) Then express the slope in **differential form** (as a derivative). How is the "d" in a derivative related to "D"?

2. What physical meaning does the slope of your position vs. time graph have? Give it a name. What is the difference between the quantities \( \frac{Dx}{Dt} \) and \( \frac{dx}{dt} \) in terms of physical meaning? Hint: Look at the graph below.
E. PHYSICAL MEANING: Each of the constants in the second-order polynomial (the coefficients a, b, and c in the curve-fitting program) has a physical significance. One of them, for example, is the initial position of the object at time \( t = 0 \); others represent acceleration or velocity values. Describe the physical meaning of each constant in a sentence or two. (If this part is confusing to you, go on to the next paragraph and then come back to this one.)

F. DEFINITIONS: Now you will need to define the concepts of **position**, **velocity**, and **acceleration**. (Remember that these are vector quantities and so a direction is included with all measurements. In this case, that is fairly simple because we are analyzing only vertical motion and therefore direction can be designated by a positive or negative value of position, as long as the coordinates are defined.)

1. Define each concept in **words**. You may use layperson's terms or simple, child-like language.

2. Start with the equation for position \( x(t) = x_0 + v_0 t + \left(\frac{1}{2}\right) a t^2 \). Differentiate once; what do you have? Differentiate a second time; what do you have now? Do you still have a function that depends on time? What does that mean?

3. Now go backwards: integrate until you reach the expression above for \( x(t) \) once again.

G. DIFFERENTIAL FORM: The second-order polynomial generated by the **Curve Fit** program can easily be linked to the position equation \( x(t) \) mentioned above:
\[ f(x) = ax^2 + bx + c \]

\[ x(t) = \left(\frac{1}{2}\right) At^2 + v_0 t + x_0 \]

(In order to distinguish the Curve Fit coefficient "a" from the symbol "a" commonly used for acceleration the symbol for acceleration in the second equation has been capitalized.) You should note that \( a = \left(\frac{1}{2}\right) A, \quad b = v_0, \quad \text{and} \quad c = x_0 \). Above you defined acceleration in differential form. Now rewrite that second-order differential equation substituting in a numerical value for acceleration \( A \).

PART 3: EXPERIMENTAL VS. PREDICTED VALUES

GOAL of this part: To check our measurements against theoretically predicted values.

Using Northstar, you will be able to solve a differential equation. ("Almost everything in physics boils down to a differential equation sooner or later!" - Professor Mook) A differential equation is simply an equation that includes one or more derivatives of a certain dependent variable; the order of a differential equation is the degree of the highest-order derivative that appears in it. (For example, an equation with a first derivative and a third derivative in it is called a "third-order differential equation.") A Skills Sheet, Differential Equations 1, discusses this in greater detail; consult this sheet if all of this seems strange to you. The program works no magic; what it does is employ techniques for solving differential equations which you have probably not yet learned, but which are by no means out of your reach.

The solution of a differential equation is a representation of the variable whose derivatives are represented. For example, if a differential equation includes various derivatives of \( x \) with respect to \( t \), then the solution will be the function \( x(t) \). Sometimes a differential equation can be solved by conventional techniques, but often an exact solution is not possible or practical and one must rely upon what are called "numerical methods" to achieve an approximate solution. Computers come in handy in finding solutions by speeding up what can sometimes become a very tedious and time-consuming process. That is where the Northstar computing system comes into the picture

You should read through the instructional document NSTAR located in the Physics 13 folder. Again, printing it out would be a good idea so that you can refer back to it as you use the program.
The Magic of Northstar: Wait a second! There's no magic here - really! Northstar is performing a task you could do the old-fashioned way - by hand, that is. The program is solving a differential equation using a technique called "integration by a fourth-order Runge-Kutta algorithm." This approach is very tedious by hand but will solve any differential equation numerically with as much accuracy as you require. You will learn other techniques. For example one could also solve the equation we are discussing here by a technique called "separation of variables" and you can learn how to use this second method yourself. There is a worksheet available to you called Differential Equations 2 in the Physics 13 folder that will show you how to do it. It's a good idea to print out this special worksheet, bronze it, and keep it with you always. The best way of analyzing most physical situations is with a differential equation, and this will be your first taste of how to do just that. Pay careful attention now because this method is one that you will repeat over and over again, and it will prove invaluable to you in the future.

A. EQUATION FORM: You should sign onto the Northterm network and run the harmonics program on NORTHSTAR by typing the word: "harmonics".

A screen will appear showing a first-order differential equation, meaning an equation including a first derivative. However, you are now dealing with acceleration, which is the second derivative of position, and you therefore need to remove the first derivative and to include a second derivative in your equation. Click on the Define Eqn box in the lower left-hand corner of the screen. When a new window opens up, click on the shaded oval next to \( \frac{dx}{dt} \) to remove this term from the equation and click on the empty oval next to \( \frac{d^2x}{dt^2} \) to add this second derivative term to the equation. (The components with the darkened ovals will appear in the equation.)

B. DEFINING EQUATION: The coefficient for the second derivative should be 1, and the value of the constant should be the negative of twice the coefficient "a" that you found in the Curve Fit program or, equivalently, the opposite of the acceleration "A". Simply click on the box (be patient - this program is usually a little slow) and when a new window appears type in the appropriate value and click OK. Record this equation in your lab notebook.

C. DEFINING PARAMETERS:

1. INITIAL CONDITIONS: Fill in the coefficient "c" from Curve Fit to represent initial position and the coefficient "b" to represent initial velocity. Record these conditions in your lab notebook.
2. **TIME PARAMETERS:** Your time step size should be the same as the interval between marks on your recording paper (1/60 of a second) so that actual points marked on the paper can be compared with the values you are calculating. Your stop time should be after the eighteenth point you plotted after time t = 0, or after 18/60 of a second. Record these values in your lab notebook. Now click on the Go box and Northstar will graph the solution curve x(t).

D. **COMPARISON:** When Northstar is through graphing the curve, bring the equation window back to the front and click on the box **Recall Previous.** Make sure that the number of your last run is highlighted and click on the box **List Table.** This will give you a table of all the points that the program plotted and the slope of the curve (first derivative) at each point, displayed in a window behind the current one. Bring that window to the front and highlight the list by dragging the mouse. Then pull down the **Edit** menu and choose **Copy.** Next, without closing Northterm (if your Mac model will allow you) open up **Microsoft Word,** use the **Edit** command **Paste** to transplant the table into a new document. Be sure to **Save** and name this document. Print it out by pulling down the **File** menu and choosing **Print,** and fasten a hard copy into your lab notebook. (If you have trouble with this, you can copy the lists of numbers into your notebook by hand.) Then compare this list of values to the one you recorded from the Spark Timer and comment on your comparison.

**Percent Error:** Calculate the percent error of your value for acceleration due to gravity with the accepted value 9.81 m/s^2.

**Uncertainty:** Remember to include an assessment of the uncertainty of your work. Be quantitative whenever possible (for example, estimate the uncertainty in your measurements using the meter stick) and qualitative about the rest. Also mention possible sources for your uncertainty.

This work should be completed before leaving the lab. Your TA will look it over while you complete the check-out sheet. Be sure to pick up the follow-up assignment that goes along with this laboratory exercise.
Lab 1 Checkout: Kinematics

While your TA is looking over the work you have done in the lab, please complete this sheet. Use only your own brain. Your answers to the first three questions will be graded as part of your lab, and your answers to all the questions will help us gauge the effectiveness of this lab.

1. What is a differential equation? Express velocity and acceleration in differential form.

2. If the polynomial \( f(x) = ax^2 + bx + c \) is an equation describing an object's position \( f \) as a function of time, what do \( , x, a, b, \text{ and } c \) represent?

3. What are the standard units of position, velocity, and acceleration?

Comments or Suggestions: How did you feel about the lab? What was good about it? What would you change?
The purpose of this exercise is for you to use your knowledge of kinematics in order to apply the procedure used in the first laboratory to a two-dimensional system. The free-falling object analyzed in the lab was restricted to one dimension, but here we will tackle a problem in a plane. In class you saw Professor Mook toss a soccer ball across the room, and it is the motion (both vertical and horizontal) of that soccer ball which you will now analyze.

**Overall GOAL:** To determine the equations, in differential form, that describe the motion of a tossed ball.

**PART 1: DATA**

**GOAL:** To gather usable data (time and position) from a tossed soccer ball.

A soccer ball was tossed and its path was recorded with the help of a video camera. The position of the ball (both vertically and horizontally) at regular intervals of time was then plotted. Using the Photodigitizer contained in your P13 HyperCard stack, you can obtain values for a horizontal component and a vertical component of position, each of which needs to be treated separately as a function of time because (and here is the important part) the ball's horizontal and vertical motions operate independently of each other.

You should also note that the ball bounces once and that the mathematical representations of its vertical and horizontal motions will be different before and after the bounce. (This would appear as a discontinuity in the curve if you were to graph the whole sequence of the ball's horizontal or vertical position versus time.) An analysis of these sets of data points will lead us to FOUR equations, one each for:

1. vertical motion before the bounce
2. vertical motion after the bounce
3. horizontal motion before the bounce
4. horizontal motion after the bounce
A. **INTRODUCTION:** Find the program **Photodigitizer** on the HyperCard stack map and hit the **Introduce Me** button if you need to be introduced. Otherwise, skip the introduction and begin.

B. **OBTAINING POSITION DATA:** Show the picture entitled **Each 2 frames**, which stores the graphical data for the tossed soccer ball you saw in class. Move to the far right of the picture because that's where the soccer ball started. You need to record in a data file the coordinates of the ball for the plotted positions on the graph, each of which is numbered. (The **Photodigitizer** introduction tells you how to do this.) Print out these data to fasten into your lab notebook, or record the data in your lab notebook as a table with the headings **x-coord**, **y-coord**, and **frame**. **Important:** Be sure to comment on the orientation of the Photodigitizer coordinate system; in other words, tell whether the numbers increase or decrease as you move upwards or to the right.

C. **CONVERSION FACTORS:** You need to determine the **frames/second ratio** and the **pixels/meter ratio** after measuring the ends of the meter stick. You will use these values later to convert your measurements from pixels to meters and frames to seconds.

PART 2: **GRAPHICAL and ALGEBRAIC APPROACH**

**GOAL:** To find an appropriate set of **four** polynomial equations and an appropriate set of **four** differential equations to describe the motion of the tossed soccer ball.

Once you have your data points, you again need to narrow down your choices for equations to describe the ball's motion. Use the program **Curve Fit 0.7d** (located in a folder called **Curve Fit** in the **Physics 13** folder), as you did in the lab, to find the best-fitting polynomial to describe the ball's motion for each of the four cases mentioned above. **A reminder: you will need to go through the process FOUR times in total, once for each of the two components of the ball's motion before the bounce and once for each component after the bounce.**

You should have printed out and saved the instructions for the **Curve Fit 0.7d** program for the first laboratory. If you do not have them, they are included in the **Curve Fit** folder.

A. **DATA INPUT:** You should determine which variable is **independent** (**X-Coord**) and which is **dependent** (**Y-Coord**) - time or position (whether it is horizontal or vertical position), and label them as such. After you fill in the data points, the program will plot them for you.
B. FITTING EQUATIONS: Now, pull the Curve Fit menu down and try to fit each of your four sets of data to (1) a linear equation, (2) a second-order and (3) a third-order polynomial, as we did in lab. **You may make assumptions that will cut out some of these trials based on your previous work in the lab and your knowledge of kinematics, but you must justify them with a written explanation.** Please include equations (and graphs if you print them out) at least for the **FOUR** equations that you choose as best-fitting, in addition to those for any other trials you run.

C. ANALYSIS: Which type of equation fits your data best for each case? (Remember what that means: the simplest equation that gets the job done.) Why is the answer not the same for horizontal and vertical motion? Explain in a sentence or two.

D. PHYSICAL MEANING: Each of the constants in the first and second-order polynomials (the coefficients a, b, and c in the curve-fitting program) has a physical meaning. One of them, for example, is the initial horizontal position of the ball at time t = 0; others are related to acceleration or velocity values. For each of the **FOUR** equations you chose, describe the physical significance of each constant in a sentence or two. Specify which equations refer to vertical and which refer to horizontal motion. (Note that the value of "a" in one equation is not necessarily the same as that in another equation. The same goes for "b," etc.)

E. UNIT CONVERSION: You should remember that the constants that you just defined are not in meters and seconds, but in pixels and frames because those are the units of the initial measurements. You now need to convert each of these values to MKS units (that's meters-kilograms-seconds) by the process of Unit Analysis. There's a good chance you are already familiar with this method, but you should consult the skills sheet "unit analysis" (in the Skills Sheet folder that you obtained from Public along with the rest of the Physics 13 materials) provided to be sure you understand why it works. Be sure to show these calculations in your lab notebook.

F. HORIZONTAL MOTION: Write a description of the ball's horizontal motion as a set of two **first-order differential equations** (equations with first derivatives in them). You need two because the cases before and after the bounce need to be handled separately. (Hint: You are going to need a value for velocity with the units meters/second.)

G. VERTICAL MOTION: Write a description of the ball's vertical motion as a set of two **second-order differential equations** (equations with second derivatives in them). You need
two because the cases before and after the bounce need to be handled separately. (Hint: You are going to need a value for acceleration with the units meters/second\(^2\).)

PART 3: EXPERIMENTAL VS. PREDICTED VALUES

GOAL: To check your measurements against theoretically predicted values.

You should still have the instructional document **NSTAR** in printed form from the first lab. If not, it is located in the **Physics 13** folder.

A. **EQUATION FORM:** Now run the **harmonics** program on NORTHSTAR. You will have to make a separate run for each of the **FOUR** differential equations you wrote at the end of the last section. **You should, however, use constant values for velocity and acceleration with the units pixels and frames so that the solution values you get can be compared directly with those you got from the Photodigitizer; in other words, go back to the values you had in (D) of the last section.** Click on the **Define Eqn** box and darken the ovals of the components you want. Then enter the correct values into the equation.

B. **PARAMETERS:** Type in the **initial conditions** from the appropriate constants you got from the **Curve Fit** program, also in units of pixels and frames. If you are unsure about this, refer back to D of the last section. Also set your **step size** and **time stop** at values appropriate for the intervals and durations of your **Photodigitizer** measurements, in pixels and frames, so that the points calculated by harmonics can be directly compared to those from the **Photodigitizer.** Then click on **Go** and Northstar will plot the solution curve for you.

C. **COMPARISON:** When Northstar is through graphing the curve, bring the equation window back to the front and click on the box **Recall Previous.** Make sure that the number of your last run is highlighted and click on the box **List Table.** This will give you a table of all the points that the program plotted and the slope of the curve (first derivative) at each point, displayed in a window behind the current one. Bring that window to the front and highlight the list. Then **Copy** the text, open up **Microsoft Word** (without closing Northterm if your computer will allow you), and **Paste** the table onto a new Word document. **Be sure to Save** and name this document. Print it out and fasten a hard copy into your lab notebook. (If you have trouble with this, you can simply copy the lists of numbers into your lab notebook from the screen.) Then compare this list of values to the one you recorded from the **Photodigitizer** and comment on your comparison in a sentence or two. Be sure to do this for each of your four equations.
Percent Error: Use the value you got for vertical acceleration before the bounce (in meters/second$^2$) to calculate percent error against the accepted value for acceleration due to gravity, 9.81 m/s$^2$. Do a second comparison for the vertical acceleration after the bounce.

Uncertainty: Remember to include an assessment of the uncertainty of your work. Be quantitative whenever possible (like with pixel uncertainty) and qualitative about the rest. Also mention possible sources for your uncertainty.

Your lab TA will inform you of where and when to turn in this exercise. If you have any problems with it, try working with a friend who is roughly at your level of comprehension. If you are still stuck, contact your TA or Professor Mook.